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1. INTRODUCTION 
 
1.1 The Macatawa Watershed 
The Macatawa River Watershed drains an area of 175 square miles in southern Ottawa 
and northern Allegan Counties in southwestern Michigan. The Macatawa River and its 
tributaries flow into Lake Macatawa, an 1808 acre, 5 mile long body of water which 
empties into Lake Michigan through a short channel. Pine Creek drains the northwestern 
part of the watershed directly into Lake Macatawa. 
 
The watershed encompasses the cities of Holland and Zeeland and most of the townships 
of Park, Holland and Zeeland as well as parts of Port Sheldon, Olive, Blendon, 
Georgetown and Jamestown townships in Ottawa County and parts of Manlius, Overisel, 
Fillmore and Laketown townships in Allegan County.  
 
The region is relatively flat with a maximum elevation above Lake Michigan of 
approximately 35 meters. The land has been extensively drained for agriculture and 
almost 50% of the watershed is characterized as prime farmland soil by the U. S. 
Department of Agriculture. 
 
1.2 Protection Priority Criteria 
The unit of comparison used in this study is the survey quarter-quarter section (see 
Appendix A for discussion of possible comparison units). Each quarter-quarter section or 
part quarter-quarter section was assigned a protection score based on the value of each of 
the criteria used in assessing protection potential. Protection priority was determined by 
summing the criteria scores and comparing the totals for each comparison unit. 
 
The original datasets used to quantify the criteria are described in the appendices. Most of 
the original data was extensively modified as described in Part 2 - Data Preparation. The 
result was the assignment of a numerical measure of protection value for each criterion. 
 
The following is a brief outline of the criteria used: 
Land Cover/Use values were based on the percentage area of each cover type in a given 
quarter-quarter section. (Cover types are described in Appendix B). Note that most 
quarter-quarter sections are approximately 40 acres (88% are between 35 and 45 acres). 
Smaller units are generally those around the periphery of the watershed which have been 
clipped to fit. 
 
Hydro values were based on the length of hydro features in each quarter-quarter section. 
Hydro features are subdivided into Lake/pond,  river/steam and drain categories. Scores 
are weighted to reflect the relative values of each category. 
 
Biological Rarity Index values (Appendix C) are assigned by the Michigan Natural 
Features Inventory to each block of an arbitrary 40 acre grid. The survey quarter-quarter 
section grid used for the model is also comprised mainly of 40 acre blocks but the two 
grids do not correspond. In order to assign RI values to each quarter-quarter section the 
area of each part of an MNFI grid unit lying within a quarter-quarter section was 
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multiplied by the MNFI RI value of the grid unit and the products were summed for all 
MNFI part units lying within each quarter-quarter section. The total obtained for each 
quarter-quarter section was then divided by the area of the quarter-quarter section to give 
the project (MAC) RI value for each survey quarter-quarter section. 
 
Development Pressure values were based on difference between the Purdue University 
Land Transformation Model (Appendix D) predicted urban land cover for each quarter-
quarter section in 2015 and the predicted values for 2005. The predicted increase in 
urbanization was taken as a measure of short-term development pressure. 
 
Proximity to Protected Areas. Protection scores were assigned to quarter-quarter 
sections which have undeveloped areas adjacent to property parcels which already have 
some degree of protection from development. Protected areas were identified on property 
parcel datasets by referring to the websites of state, county and local government 
organizations and land conservation organizations in the watershed (Appendix E). 
 
Ground Water Recharge. The Mi DNR Darcy Potential Groundwater Movement Model 
(Appendix F) is a raster dataset showing the input or output of groundwater from each 30 
meter grid unit of the model to the nearest surface water body (lake, stream, etc.). 
Protection values for this study were obtained by averaging recharge over each quarter-
quarter section. Areas with higher recharge rates were assigned higher protection scores 
because they have a greater effect on downstream surface water and thus on the 
watershed as a whole. Areas with negative recharge rates (surface water flowing into the 
grid unit ground water) were assigned zero value. 
 
Agricultural Soil Quality. Natural habitat is characterized by having a diverse biota and 
being self-sustaining, at least if the ecosystem is large enough. Farmland, on the other 
hand, is generally a monoculture and requires constant human intervention to maintain its 
character. Thus the criteria used to assess the value of the two land types may be quite 
different. Because both types of land need protection, negative values have been assigned 
to quarter-quarter sections in this study which have large areas of prime farmland soil as 
determined by the USDA (Appendix G). This will tend to insure that if natural areas of 
equal potential are being considered for protection the one that has less prime farmland 
soil will be preferred. 
 
1.3 Methodology Outline 
The procedure for creating the model comprised the following steps: 
 

• Creation of a survey quarter-quarter section ESRI file geodatabase feature class to 
serve as a base or framework for the model. 

• Creation and/or modification of a geodatabase feature class representing each of 
the protection criteria. 

• Establishment of a numerical attribute (area, length, percentage, index or nominal 
value, etc.) which best represents the contribution each criterion makes to the 
quality of the landscape.  
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• Addition of the attribute values for each of the criteria to the framework feature 
class (model) attribute table. 

• Classification (if necessary) of each criterion attribute. 

• Weighting (scoring) of each criterion attribute for each quarter-quarter section. 

• Computation of a total protection score for each quarter-quarter section by the 
addition of the scores for each criterion. 

• Testing of outcomes against DOQs, parcel data and other digital resources and by 
ground-truthing. 

• Ranking and symbolization of the outcome for display in a map. 
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2.  DATA PREPARATION 
 
2.1  Watershed Boundary 
Data Source 
 Macc_Watershed.shp. 
Dataset provided by the Macatawa Area Coordinating Council. 
 
Processing 
Macc_Watershed.shp reprojected from: 
NAD_1983_Michigan_GeoRef_Meters 
to: 
NAD_1983_Hotine_Oblique_Mercator_Azimuth_Natural_Origin. 
 
Dataset imported into ESRI file geodatabase as: 
 MAC2.gdb/MAC_WS_Bound. 
 
2.2  Survey Quarter-Quarter Section Base Feature Class 
Data Source  
ottawa_quarter_quarter_sections.shp  
and  
allegan_quarter_quarter_sections.shp  
Datasets created by the Michigan Department of Natural Resources and downloaded 
from the Michigan Geographic Data Library. 
 
Processing 
Select by Location from allegan_quarter_quarter_sections.shp and 
ottawa_quarter_quarter_sections.shp records which intersect 
MAC2.gdb/MAC_WS_Bound.  
 
Merge (Data Management Tools>General>Merge) selected records.  
 
Clip (Analysis Tools>Extract>Clip) merged dataset with MAC2.gdb/MAC_WS_Bound. 
The resulting dataset has 2950 records (QQs). 
 
Delete fields AREA and PERIMETER from attribute table because they refer to the un-
clipped records. New areas and perimeters are given by Shape_Area and Shape_Length. 
 
Delete records less than 1 acre (52 records). 2898 records remain. (The small polygons 
are slivers along the edges of the boundary). 
 
Add field: 
 MAC_ID (short integer).  
Populate field with sequential values 1 to 2898. 
 
Save dataset as: MAC2.gdb/MAC_QQ. 
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Add field:  
MAC_Acres (double) 
Populate using Calculate Geometry. 
 
2.3  Land Cover/Land Use 
Data Source 
Original Dataset: lu2005.shp developed by the Michigan Department of Environmental 
Quality and obtained from the Macatawa Area Coordinating Council. (Total acres = 
111677). 
 
In preparing data for the priority model extensive revisions were made to polygons in the 
Michigan DEQ lu2005.shp dataset. Changes were made by comparison to 1998 and 2005 
aerial imagery and ground-truthing. Revisions included reclassification and splitting of 
some polygons. No polygons were re-drawn. During the revision process some farmland 
areas were reclassified to other cover types and some non-farmland areas were 
reclassified as farmland. The new classification system is described in Appendix B. 
 
Processing 
Define projection as: 
NAD_1983_Hotine_Oblique_Mercator_Azimuth_Natural_Origin.prj 
 
Save dataset as MAC2.gdb/MAC_Cover. 
 
Edit features as described above. 
 
Add Fields:  
M_Class (text, 5). 
M_Type (text, 12). 
M_Acres (double). 
M_AgClass (text, 5) 
M_AgType (text, 15) 
 
Use Calculate Geometry to populate MAC_Acres field. 
 
Use Field Calculator to populate MAC_Class, MAC_Type, MAC_AgClass and 
MAC_AgType fields with appropriate Class symbol and type designation (see: Appendix 
B).  
 
2.4  Hydro 
Data Source 
Ottawa Hydro Framework: hydro_139v8a.shp. 
Allegan Hydro Framework: hydro_005v8a.shp. 
  
These datasets are maintained and distributed by the Michigan Center for Geographic 
Information and were downloaded from the Michigan Geographic Data Library. 
(www.mcgi.state.mi.us/mgdl/). 
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Processing 
Select by Location from hydro_139v8a.shp and hydro_005v8a.shp features that are 
within MAC2.gdb/MAC_WS_Bound . Export selected features to 
MAC2.gdb/Hydro_Ottawa and MAC2.gdb/Hydro_Allegan. 
 
Merge (Data Management Tools>General>Merge): MAC2.gdb/Hydro_Ottawa and 
MAC2.gdb/Hydro_Allegan. Output: 
MAC2.gdb/MAC_Hydro. 
 
Edit features in MAC2.gdb/MAC_Hydro to conform more closely to 2005 and 1998 DOQ 
aerial imagery. DRGs, DEMs and ground-truthing consulted to improve accuracy.  
 
Note: The following two steps were carried out by reference to 1998 and 2005 aerial 
imagery (DOQs) and Mi DEQ Land Use/Land Cover dataset (lu2005.shp). 
 
Remove lake features (FCC = H21) where lake shorelines within a quarter-quarter section 
are completely developed (built up). 
 
Digitize unrecorded lakes and ponds greater than 5000m2. Mark FCC = H21 and ver = 
“jdf”. (85 new features created. 127 total H21 features). 
 
Change FCC class of Lake Macatawa mouth features from H32 (two-bank stream) to 
H21 (lake shoreline). 
 
2.5  Biological Rarity Index 
Original Data 
Original data contained in ottawa_ri.shp and allegan_ri.shp Biological Rarity Index and 
Probability Value datasets developed by the Michigan Natural Features Inventory 
(3/31/2006). Each dataset provides a probability model and a biological rarity index 
model for the appropriate county. 
Data downloaded from the Michigan Geographic Data Library. 
 
Processing 
ottawa_ri.shp and allegan_ri.shp reprojected from:  
NAD_1983_Michigan_GeoRef_Meters 
to: 
NAD_1983_Hotine_Oblique_Mercator_Azimuth_Natural_Origin. 
 
Merge (Data Management Tools>General>Merge) ottawa_ri.shp and allegan_ri.shp to 
form ottawa_allegan_Merge.shp. 
 
Select by location from ottawa_allegan_Merge.shp records that are intersected by 
MAC2.gdb/MAC_WS_Bound .  
Export selected records to MAC2.gdb/MAC_MNFI. 
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Add Field: 
RI_Area (double). 
 
2.6  Development Pressure 
Data Source 
Data was in the form of a series of ArcGIS Grid (raster) files representing actual land use 
in the state of Michigan for the year 2000 and predicted land use for the years 2005, 
2010, 2015, 2020, 2025 and 2030. 
Data was downloaded from the Purdue University Land Transformation Model web site. 
(http://ltm.agriculture.purdue.edu/ltm.htm). 
 
Processing 
Convert(Conversion Tools>From Raster>Raster to Polygon) raster datasets to polygons 
(Field = VALUE; uncheck Simplify Polygons). 
 
From new vector datasets Select by Location polygons that intersect 
MAC2.gdb/MAC_WS_Bound. 
Export selections to: 
MAC2.gdb/MAC_LTM2005. 
MAC2.gdb/MAC_LTM2015. 
 
Select urban polygons (gridcode = 11, 12, 13 or 14) and export selections to: 
MAC2.gdb/Urban2005. (4290 records). 
MAC2.gdb/Urban2015. (5591 records). 
 
Merge (Edit>Merge) output records within each feature class.  
Delete field: ID 
Populate 'GRIDCODE' field with 1. 
 
2.7  Protected Areas 
Protected Parcels are property parcels which currently (2009) have some degree of 
protection from development through their designation as parks, preserves or nature areas 
or due to the presence of a conservation easement. A few parcels of  undeveloped public 
land (state, county or municipal) are also included. 
 
Protected Areas are protected parcels or groups of protected parcels. Generally, parcels in 
a protected area will have the same owner but there are some exceptions such as 
Holland's Outdoor Discovery Center. Also, parcels in a protected area are usually 
contiguous but not always (Holland City Greenway parcels, Greenway Partnership 
parcels). 
 
The Macatawa Greenway is a projected natural corridor running along the Macatawa 
River from downtown Holland to Zeeland Township. Current components of the 
Greenway comprise both public and private lands. The project is administered by the The 
Outdoor Discovery Center - Macatawa Greenway Partnership (ODC-MGP), a nonprofit 
environmental education and conservation organization. Some components of the 
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Greenway are named parks or preserves and are listed as such under AreaName in the 
datasets attribute table - otherwise they are listed as 'Macatawa Greenway'. 
 
Processing 
Create new polygon feature class MAC2.gdb/MAC_Protect. 
 
Add Fields: 
AreaName (text, 35) 
Location (text, 15) 
AcresMAC (double) 
Parcels (short integer) 
OwnerType (text, 10) 
Owner1 (text, 35) 
Owner2 (text, 35) 
Owner3 (text, 35) 
Status (text, 5) 
NotesMAC (text, 25) 
 
Append (Data Management Tools>General>Append) protected parcel features from 
county property parcel layers to MAC2.gdb/MAC_Protect (Schema Type = NO TEST). 
 
Merge (Edit>Merge) parcels where there is more than one property parcel in a protected 
area (see above). 
 
Populate attribute fields of MAC2.gdb/MAC_Protect with attribute information from 
Appendix E. 
 
2.8  Ground Water Recharge 
Data Source 
Darcy Potential Groundwater Movement Model (Input-Output), Michigan DNR Fisheries 
Division, Institute for Fisheries Research raster dataset asciito_darc2.rrd downloaded 
from the MI DNR Geographic Data Library. 
 
Processing 
Extract (Spatial Analyst>Extract>Extract by Mask) from asciito_darc2.rrd using 
MAC2.gdb/MAC_WS_Bound as mask: 
Output raster grid: asciito_ex. 
 
Convert (Conversion Tools>From Raster>Raster to Polygon) raster dataset asciito_ex to 
vector dataset MAC2.gdb/MAC_GWR. 
 
2.9  Soil Quality 
Data Source 
Allegan County Soil Survey Data (Survey Area Version 8; Tabular Data Version 7; 
Spatial Data Version 5; (SSURGOV2.1, MD 2.2.3) 
and 
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Ottawa County Soil Survey Data (Survey Area Version 4; Tabular Data Version 4; 
Spatial Data Version 2; (SSURGOV2.1, MD 2.2.2): 
 
The data is provided in the form of shapefiles (soilmu_a_mi005.shp and 
soilmu_a_mi139.shp) which show the spatial extent of soil types in the respective 
counties. In addition, a set of tabular data which contains attribute information on the soil 
types is provided, as well as a Microsoft Access template database 
(soildb_MI_2002.mdb). The tabular data can be imported into the Access template and 
reports created. 
 
All original data was created by United States Department of Agriculture, Natural 
Resources Conservation Service and downloaded from the Soil Data Mart: 
http://soildatamart.nrcs.usda.gov/ 
 
Processing 
soilmu_a_mi005.shp and soilmu_a_mi139.shp reprojected from:  
NAD_1983_Michigan_GeoRef_Meters 
to: 
NAD_1983_Hotine_Oblique_Mercator_Azimuth_Natural_Origin. 
 
Select by Location features from soilmu_a_mi005.shp and soilmu_a_mi139 that intersect 
MAC2.gdb/MAC_WS_Bound and output selected data as: 
MAC2.gdb/MSoil005 and 
MAC2.gdb/MSoil139. 
 
Select by Attributes from MAC2.gdb/MSoil005 features where MUSYM field attribute 
equals one of the Map Symbols listed in the Prime and Other Important Farmlands report 
for Allegan County as ‘All areas are prime farmland’. Export selected features. 
Output: MAC2.gdb/MSoil005_prime. 
 
Select by Attributes from MAC2.gdb/MSoil005 features where MUSYM field attribute 
equals one of the Map Symbols listed in the Prime and Other Important Farmlands report 
for Allegan County as ‘Prime farmland if drained’. Export selected features. 
Output: MAC2.gdb/MSoil005_drained. 
 
Select by Attributes from MAC2.gdb/MSoil139 features where MUSYM field attribute 
equals one of the Map Symbols listed in the Prime and Other Important Farmlands report 
for Ottawa County as ‘All areas are prime farmland’. Export selected features. 
Output: MAC2.gdb/MSoil139_prime. 
 
Select by Attributes from MAC2.gdb/MSoil139 features where MUSYM field attribute 
equals one of the Map Symbols listed in the Prime and Other Important Farmlands report 
for Ottawa County as ‘Prime farmland if drained’. Export selected features. 
Output: MAC2.gdb/MSoil139_drained. 
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Merge (Data Management Tools>General>Merge) MAC2.gdb/MSoil005_prime, 
MAC2.gdb/MSoil005_drained, MAC2.gdb/MSoil139_prime and 
MAC2.gdb/MSoil139_drained. 
Output: MAC2.gdb/MAC_PrimeSoil. 
 
  



MACC2 13 01/31/2010 

3.  MODEL CREATION 
 
Data Sources 
Watershed boundary: MAC2.gdb/MAC_WS_Bound. (Data Preparation 2.1). 
Survey quarter-quarter sections: MAC2.gdb/MAC_QQ. (Data Preparation 2.2). 
Land Cover/Use: MAC2.gdb/MAC_Cover. (Data Preparation 2.3). 
Hydro: MAC2.gdb/MAC_Hydro. (Data Preparation 2.4). 
Biological Rarity: MAC2.gdb/MAC_MNFI. (Data Preparation 2.5). 
Development Pressure: MAC2.gdb/Urban2005 and MAC2.gdb/Urban2015. (Data 

Preparation 2.6). 
Proximity to Protected Areas: MAC2.gdb/MAC_Protect. (Data Preparation 2.7). 
Groundwater Recharge: MAC2.gdb/MAC_GWR. (Data Preparation 2.8). 
Prime Soils: MAC2.gdb/MAC_PrimeSoil. (Data Preparation 2.9). 
 
Processing 
Delete all fields from MAC2.gdb/MAC_QQ except: 
OBJECTID 
Shape 
COUNTY 
TOWN 
GEO_ID 
MAC_ID 
Shape_Length 
Shape_Area 
MAC_Acres 
 
Save result as: 
MAC2.gdb/MAC_Model. 
 
Land Cover/Use 
To MAC2.gdb/MAC_Model add field:  
MAC_Built (text, 5) 
Quarter-quarter sections with no undeveloped parcel greater than 5 acres were designated 
‘B’ in MAC_Built field. (318 features). 
Quarter-quarter sections consisting entirely of water were designated ‘L’ in MAC_Built 
field. (22 features). 
All other quarter-quarter sections were designated ‘S’. 
 
To MAC2.gdb/MAC_Model add fields:  
M1 (float) 
M19 (float) 
M2 (float) 
M29 (float) 
M31 (float) 
M32 (float) 
M4 (float) 
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M429 (float) 
M5 (float) 
M53 (float) 
M6 (float) 
M7 (float) 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model with 
MAC2.gdb/MAC_Cover (NO FID; Output Type = INPUT). 
Output: MAC2.gdb/Intersect_Cover. 
 
Select by Attributes from MAC2.gdb/Intersect_Cover where M_Class = M19. 
 
Summarize selected records on field MAC_ID for Shape_Area (Sum). 
Output Table: MAC2.gdb/Sum_M19. 
 
Join table MAC2.gdb/Sum_M19 to MAC2.gdb/MAC_Model based on field MAC_ID. 
 
Use Field Calculator to populate model M19 field [MAC_Model.M19] with percentage 
of M19 cover in each model feature (quarter-quarter section) using expression: 
([Sum_M19.Sum_Shape_Area] / [MAC_Model.Shape_Area]) *100 
 
Remove Join. 
 
Repeat the previous 5 operations for each of the land cover classes M2 to M7. 
 
Comparison of the lan cover dataset and 2005 DOQ imagery revealed significant changes 
from Water to Wetland cover in some areas, especially near downtown Holland. In order 
to avoid redrawing polygons in the Cover dataset (because this may not reflect a 
permanent drop in water level), these changes were reflected by reducing proportion of 
Water cover and increasing proportion of Wetland cover in a few QQs : 
MAC_ID = 1283 (30%), 1341 (30%), 1344 (40%), 1345 (20%). 
 
Hydro 
To MAC2.gdb/MAC_Model add fields: 
MH2 (double) 
MH3 (double) 
MH4 (double) 
 
Export feature class MAC2.gdb/MAC_Hydro to: 
MAC2.gdb/MAC_Hydro_Merge. 
 
Delete all two-banked streams (H32) and replace with a single screen digitized H31 
feature. 
 
Edit/Merge all features where FCC = H31, H32 or H33 into a single feature where FCC = 
H3. 
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Edit/Merge all features where FCC = H41 into a single feature where FCC = H4. 
 
Edit/Merge all features where FCC = H21 into a single feature where FCC = H2. 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model with 
MAC2.gdb/MAC_Hydro_Merge (NO FID; Output Type = INPUT). 
Output: MAC2.gdb/Intersect_Hydro. 
 
Select by Attributes from MAC2.gdb/Intersect_Hydro where FCC = H2. 
 
Summarize selected records on field MAC_ID for Shape_Length (Sum). 
Output Table: MAC2.gdb/Sum_MH2. 
 
Join table MAC2.gdb/Sum_MH2 to MAC2.gdb/MAC_Model based on field MAC_ID. 
 
Use Field Calculator to populate model MH2 field [MAC_Model.MH2] with length of 
lake perimeter (H2) in each quarter-quarter section. 
 
Remove Join. 
 
Repeat the previous 5 operations for hydro types H3 and H4. 
 
MNFI Species Rarity Index 
To MAC2.gdb/MAC_Model add field:  
MRI (float) 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model and 
MAC2.gdb/MAC_MNFI. 
Output: MAC2.gdb/Intersect_MNFI. 
 
Use Field Calculator to populate MAC2.gdb/Intersect_MNFI RI_Area field with: 
RI x Shape_Area 
 
Summarize on field MAC_ID for field RI_Area (Sum). 
Output table: MAC2.gdb/Sum_RIArea. 
 
Join MAC2.gdb/MAC_Model and MAC2.gdb/Sum_RIArea using MAC_ID as join field. 
 
Use Field Calculator to populate model MRI field [MAC_Model.MRI] with project rarity 
index (RIarea for each QQ/area of QQ) for each QQ using the expression: 
[MAC_Model.MRI] = [Sum_RIarea.Sum_RI_Area] / [MAC_Model.Shape_Area] 
 
Remove Join. 
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Development Pressure 
To MAC2.gdb/MAC_Model add field:  
MDev (double) 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model with 
MAC2.gdb/Urban2005 and MAC2.gdb/Urban2015. 
Output:  
MAC2.gdb/Intersect_2005. 
MAC2.gdb/Intersect_2015. 
 
To MAC2.gdb/Intersect_2015 add field:  
S_A_2005 (double). 
 
Join MAC2.gdb/Intersect_2015 and MAC2.gdb/Intersect_2005 using MAC_ID as the join 
field. 
 
Using Field Calculator populate MAC2.gdb/Intersect_2015 S_A_2005 field with values 
in MAC2.gdb/Intersect_2005 Shape_Area field. 
 
Select by Attributes records where S_A_2005 field values are ‘NULL’ and use Field 
Calculator to populate selected fields with ‘0’. 
 
Remove Join. 
 
Join MAC2.gdb/MAC_Model and MAC2.gdb/Intersect_2015 using MAC_ID as join 
field. 
 
Use Field Calculator to populate model MDev field [MAC_Model.MDev] with the 
difference between the area of 2015 urban records and the area of 2005 urban records 
(field S_A_2005)  using expression: 
MAC_Model.MDev = [Intersect_2015.Shape_Area] - [Intersect_2015.S_A_2005]. 
 
Remove Join. 
 
Proximity to Protected Areas  
To MAC2.gdb/MAC_Model add field:  
MPrx (short integer). 
 
Select by Location from MAC2.gdb/MAC_Model features which intersect 
MAC2.gdb/MAC_Protect. 
 
Export selected features to new feature class: 
MAC2.gdb/MAC_Prox. 
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By reference to MAC2.gdb/MAC_Cover, delete features from MAC2.gdb/MAC_Prox 
which have only land cover characterized as M1 or M29 (built up land) in contact with 
protected land from MAC2.gdb/MAC_Protect. 
 
By inspection, populate the MPrx field of the remaining features in 
MAC2.gdb/MAC_Prox with one of 5 values: 
1 = QQs which share a border equal to or greater than 50 m with protected features from 

MAC2.gdb/MAC_Protect. 
2 = QQs which share a border less than 50 m with protected features from 

MAC2.gdb/MAC_Protect. 
3 = QQs which are entirely protected. 
4 = QQs which contain some protected land but no other undeveloped land. 
5 = QQs which contain some protected land and some adjacent undeveloped land. 
 
Join MAC2.gdb/MAC_Model and MAC2.gdb/MAC_Prox using MAC_ID as join field. 
 
Using Field Calculator, populate model MPrx field [MAC_Model.MPrx] with values 
from MAC2.gdb/MAC_Prox MPrx field [MAC_Prox.MPrx]. 
 
Remove Join. 
 
Groundwater Recharge 
To MAC2.gdb/MAC_Model add field:  
MGw (double). 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model and 
MAC2.gdb/MAC_GWR. 
Output: MAC2.gdb/Intersect_GWR. 
 
Summarize on field MAC_ID for field GRIDCODE (Mean). 
Output table: MAC2.gdb/Sum_GWR. 
 
Join MAC2.gdb/MAC_Model and table MAC2.gdb/Sum_GWR using MAC_ID as join 
field. 
 
Using Field Calculator, populate model MGw field [MAC_Model.MGw] with values 
from table Ave_GRIDCODE field [Sum_GWR.Ave_GRIDCODE]. 
 
Remove Join. 
 
Soil Quality 
To MAC2.gdb/MAC_Model add field:  
MFm (double). 
 
Intersect (Analysis Tools>Overlay>Intersect) MAC2.gdb/MAC_Model and 
MAC2.gdb/MAC_PrimeSoil. 
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Output: MAC2.gdb/Intersect_Soil. 
 
Summarize on field MAC_ID for field Shape_Area (Sum). 
Output table: MAC2.gdb/Sum_Soil. 
 
Join table MAC2.gdb/Sum_soil to MAC2.gdb/MAC_Model based on field MAC_ID. 
 
Use Field Calculator to populate model MFm field [MAC_Model.MFm] with percentage 
of prime soil cover in each QQ section using expression: 
([Sum_Soil.Sum_Shape_Area] / [MAC_Model.Shape_Area]) *100 
 
Remove Join. 
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4.  MODEL SCORING 
 
4.1 Scoring Considerations   
There are no ‘right’ scores for each of the criteria chosen just as there are no ‘right’ total 
scores for each of the quarter-quarter sections. The computer cannot decide what weights 
to assign to each of the criteria because the criteria are of different types: percentage area 
of forest vs. meters of stream, for example. Humans must decide the comparative value 
of forest vs. stream. The machine merely crunches the numbers and adds them up. The 
beauty of the computer model is that the weights can be changed and the model re-run to 
produce different outcomes. This is vital because in the end the rankings must reflect 
real-world conditions on the ground as well as the actual preferences of the stakeholders. 
 
In practice a number of factors were taken into account when assigning weights: 
• The need to separate the comparison units numerically so they can be effectively 

ranked. If too many units get the same score the prioritization is less useful. 
• The need to ensure that slight differences in the value of a criterion do not result in 

large differences in score. A unit which has 69.9% of a given value should not score 
significantly less than a unit which has 70% of the value. 

• The limitations of the technology. Some criteria may be represented more accurately 
than others and that should be reflected in the scores. 

 
4.2 Classification and Weighting 
Processing 
To MAC2.gdb/MAC_Model add fields:  
M1_PS (short integer) 
M19_PS (short integer) 
M2_PS (short integer) 
M29_PS (short integer) 
M31_PS (short integer) 
M32_PS (short integer) 
M4_PS (short integer) 
M429_PS (short integer) 
M5_PS (short integer) 
M53_PS (short integer) 
M6_PS (short integer) 
M7_PS (short integer) 
MH2_PS (short integer) 
MH3_PS (short integer) 
MH4_PS (short integer) 
MRI_PS (short integer) 
MDev_PS (short integer) 
MPrx_PS (short integer) 
MGw_PS (short integer) 
MFm_PS (short integer) 
Total_PS (short integer) 
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Save MAC2.gdb/MAC_Model as: 
MAC2.gdb/MAC_Model_B. 
 
Classify protection criteria fields (M1 to MFm) and apply protection scores (M1_PS to 
MFm_PS) based on values in the Protection Criteria Classification and Weighting 
Worksheet on the following pages. 
  
Calculate the Total Protection Score for each quarter-quarter section by the adding the 
scores for each of the criteria (M1_PS to MFm_PS). 
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4.3 Protection Criteria Classification and Weighting Worksheet. 
 

Criterion Field Classification QQs Bw2   
    Score   
LandCover       
       
     Built M1_PS   0   
(developed land cover).       
       
     Recreation M19_PS =< 30% 2848 0   
(% of recreation land  > 30 - =< 60 26 2   
cover in q-q).  > 60% 24 4   
       
     Agricultural M2_PS =< 30% 1213 0   
(% of agricultural land  > 30 - =< 60 332 2   
cover in q-q).  > 60% 1353 4   
       
     Built Ag M29_PS   0   
(agricultural structures)       
       
     Open Land M31_PS < 5% 2421 0   
(% of open land cover  => 5 - < 25 332 1   
in q-q).  => 25 - < 40 77 2   
  => 40 - < 50 32 6   
  => 50 - < 60 14 10   
  => 60 - < 70 9 14   
  => 70 - < 80 7 18   
  => 80% 6 22   
       
       
     Shrubland M32_PS < 5% 2531 0   
(% of shrubland land  => 5 - < 25 275 2   
cover in q-q).  => 25 - < 40 55 4   
  => 40 - < 50 12 8   
  => 50 - < 60 11 12   
  => 60 - < 70 4 16   
  => 70 - < 80 8 20   
  => 80% 2 24   
       
     Forest M4 < 5% 1825 0   
(% of forest land cover  => 5 - < 25 584 5   
in q-q).  => 25 - < 40 191 9   
  => 40 - < 50 87 13   
  => 50 - < 60 72 17   
  => 60 - < 70 44 21   
  => 70 - < 80 35 25   
  => 80% 60 29   
       
     Plantation M429 <= 10% 2892 0   
(% of plantation land  > 10 - <= 30 2 3   
cover in q-q).  > 30 - < = 60 3 5   
  => 60% 1 7   
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     Water M5 <= 10% 2796 0   
(% of open water in q-q).  > 10 - <= 30 39 2   
  > 30 - < = 60 22 3   
  > 60% 41 4   
       
     Reservoir M53 <= 25% 2896 0   
  > 25% 2 2   
       
     Wetland M6 < 1% 2709 0   
(%  of wetland cover)  => 1 - < 5 63 3   
  => 5 - < 10 42 6   
  => 10 - < 15 30 9   
  => 15 - < 20 14 12   
  => 20 - < 25 17 15   
  => 25% 23 19   
       
     Bare M7 =< 30% 2895 0   
(% of bare land cover)  > 30 - =< 60 2 2   
  > 60% 1 3   
       
       
       
Hydro       
     Lakes & Ponds MH2 < 10m 2705 0   
(meters of pond perimeter  => 10 - < 100 11 2   
in q-q).  => 100 - < 300 68 3   
  => 300 - < 500 71 5   
  => 500 - < 650 24 7   
  => 650m 19 9   
       
     Rivers MH3 < 10m 2462 0   
(meters of rivers in q-q).  => 10 - < 100 46 8   
  => 100 - < 300 107 10   
  => 300 - < 500 179 12   
  => 500 - < 650 59 15   
  => 650m 45 18   
       
     Drains MH4 < 10m 1917 0   
(meters of drains in q-q).  => 10 - < 100 109 3   
  => 100 - < 300 271 5   
  => 300 - < 500 387 7   
  => 500 - < 650 139 9   
  => 650m 75 11   
       
Species Rarity Index MRI 0 1046 0   
(index of likelyhood of   > 0 - <= 5 1226 1   
rare species in q-q).  > 5 - <= 8 530 3   
  > 8 - <= 10 61 6   
  >10 35 9   
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Development Pressure MDev <= 4047m2 1647 0   
(predicted increase in  > 4047 - <= 24282 566 1   
 area (m2) developed).  > 24282 - <= 40470 383 2   
  > 40470 - <= 60705 229 3   
  >  60705m2 73 4   
       
Proximity to Protected MPrx 0 2642 0   
(index of proximity to   1 110 10   
protected land.  2 34 7   
See page 17).  3 26 0   
  4 10 0   
  5 76 7   
       
       
Ground Water Recharge MGw <= 0 2088 0   
(average positive recharge  > 0 - <= 10 508 1   
rate in a q-q).  > 10 - <= 40 225 3   
  >40 77 5   
       
Prime Farmland MFm 0% 978 0   
(% of q-q with prime   > 0 - <=30 284 -1   
farmland soil type).  > 30 - <= 60 333 -2   
  > 60 - <= 90 515 -3   
  >90% 788 -4   
       
       
Total QQs = 2898, B = classification version,  QQs = # of QQs in class,  Bw2 = protection scores for 
classification B. (Bw2 is also the version number for this model outcome). 
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5.  CONCLUSIONS 
 
The scoring system described in the previous pages resulted in the assignment of a 
protection score to each of the quarter-quarter section comparison units in the study area. 
However, there is no single correct outcome for the priority modeling process used in this 
study. Classification and weighting of the values representing each of the criteria is a 
matter of judgment. It reflects the modeler’s best assessment of the relative importance of 
each criterion and of the quality of the data used to represent it. As far as possible the 
results must be tested against real world conditions to determine their accuracy and 
reliability. One advantage of the modeling process is that scoring can be changed 
relatively easily if outcomes fail to reflect conditions on the ground or the protection 
priorities of the stake holders in the area being assessed.  
 
This is not an ecological model designed to identify the best habitat for a particular 
species or the areas most likely to be self-sustaining. Ecological factors were certainly 
important but consideration was also given to the needs and desires of a wide range of 
stakeholders, not just scientists. In short, the model is not meant to produce an ideal 
protection priority ranking but rather to be a flexible tool which can assist decision 
makers in applying real-world priorities to land conservation decisions. 
(See Appendix J for problems encountered in creating the model). 
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Appendix A - Choosing Base Units When Prioritizing Land for Protection 
 
Natural Units 
These would comprise polygons (or raster cells) representing areas of contiguous land 
cover type: wetlands, forests, farm fields, etc. Internal barriers whether natural (streams) 
or man-made (roads) would further delimit the units. Unfortunately it is very difficult to 
create a digital layer which accurately represents most land cover types at appropriate 
resolutions. Additionally, the units in such a layer vary widely in size and so are difficult 
to compare directly for any criterion other than area of land cover. A land cover/use layer 
of some kind is essential for developing a land protection priority system but is not ideal 
for use as the base framework in such a system. 
 
Property Parcels 
Since identifying property (and landowners) is one of the main purposes of land 
protection prioritization this would seem to be the ideal unit. However, there are many 
problems with parcel data. It may not be available for some jurisdictions (counties) and 
the standards for parcel digitization are variable. The purposes for which counties use the 
data may not require high accuracy and data integrity but analysis in a GIS is not so 
tolerant. Because methods and standards are different it may be particularly difficult to 
reconcile parcel data from more than one county if a study area crosses county lines. 
Also, parcels are of different sizes. In prioritizing them a choice must be made between 
average values and absolute values. Assuming you are interested in protecting wetland, 
would you assign a higher rank to a 10 acre parcel which is 50% wetland or a 100 acre 
parcel which is 10% wetland? Finally, there are privacy issues which arise when using 
easily identified property parcels as base units in a map which is publicly available. 
 
Grids 
Grids can be created in any size and the cells have the advantage of being identical no 
matter what the political units involved. On the other hand, such grids have no relation to 
any real world characteristics, whether natural or political. In order to compare protection 
potential in different regions a standard grid would have to be adopted. 
 
Survey Quarter-Quarter Sections 
These represent a particular kind of grid. Each cell is approximately 40 acres - though 
there is some variability, especially along the edges of any study area boundary which is 
not defined by section lines. The big advantage of quarter-quarter sections is that they 
often correspond to property parcel boundaries, especially in non-urban areas, since 
boundaries are based on section lines. Also, 40 acres is close to the lower limit of 
accuracy for the best available land cover data. Finally, a standard quarter-quarter section 
dataset is freely available from the Michigan Geographic Data Library for every county 
in the State. 
 
 
  



MACC2 26 01/31/2010 

Appendix B -  Land Cover Classes 
 
M Class 
Class Type Acres Description 
M1 Developed 31847 Built up, roads 
M19 Recreation 1693 Golf, playground, vacant lot, lawn, etc.  
M2 Agriculture 53356 Farmland 
M29 Ag Structure 1294 Farmhouses, barns, greenhouses, silos, etc. 
M31 Open 4272 Herbaceous open land (meadow, overgrown farmland) 
M32 Shrubland 2958 Shrubland, some emergent trees. 
M4 Forest 12213 Mature forest 

M429 Plantation 119 Christmas trees, pine plantation, etc. 
M5 Water 2450 Open water (lakes, large two-bank rivers) 
M53 Reservoir 274 Recent, manmade lake/pond, recreational, development. 
M6 Wetland 893 Wetland (open or emergent) 
M7 Bare 318 Sand, open pit, etc. 

 
M AgClass 
Class Type Acres Description 
M21 Cropland 50902 Row crops, small grains. 
M22 Orchard 1855 Tree and bush fruits, ornamentals.  
M24 Pasture 598 Permanent pasture 
M29 Structure 1294 Farmhouses, barns, greenhouses, silos, etc. 
 
 
The original Land Cover/Use dataset used in this study was developed by the Michigan 
Department of Environmental Quality, Land and Water Management Division, 
Hydrologic Studies Unit and obtained from the Macatawa Area Coordinating Council. 
 
In preparing data for the priority model extensive revisions were made to polygons in the 
lu2005.shp dataset. Changes were made by comparison to 1998 and 2005 aerial imagery 
and ground-truthing. Revisions included reclassification and splitting of some polygons. 
No polygons were re-drawn. During the revision process some farmland areas were 
reclassified to other cover types and some non-farmland areas were reclassified as 
farmland. 
In this natural history model (Part 1) only M Classes were used. M AgClasses were used 
in the separate model prioritizing farmland for protection (Part 2). 
 
New class designations (see tables) used in the MAC study were chosen to reflect those 
used in the original dataset and also in the Michigan Land Cover/Use Classification 
System - 2000, which was originally developed by the Michigan Land Use Classification 
and Referencing Committee and is published by the Michigan Department of Natural 
Resources. 
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Appendix C - Biological Rarity Index 
 
The original data used in developing values for this criterion was taken from a probability 
model and a biological rarity index model developed by the Michigan Natural Features 
Inventory (MNFI). Both models are based on the MNFI database of known sightings of 
threatened, endangered, or special concern species and high quality natural communities. 
The model values are reported on a 40 acre polygon grid for the state of Michigan. 
 
The following is the metadata for the original dataset. (From MNFI metadata: 
http://web4.msue.msu.edu/mnfi/data/rarityindex/rarity_index_metadata.htm): 
 
Citation:  

Citation_Information:  
Originator: Michigan Natural Features Inventory 
Publication_Date: 20060331 
Title: Biological rarity index and probability value - 40 acre grid 
Geospatial_Data_Presentation_Form: vector digital data 

Description:  
Abstract:  
Two models, a probability model and a biological rarity index model, are provided in this dataset. 
Both models are based on the Michigan Natural Features Inventory (MNFI) database of known 
sightings of threatened, endangered, or special concern species and high quality natural 
communities. The model values are reported on a 40 acre polygon grid for the state of Michigan, 
or a subset of MI.  
Purpose:  
The probability value is designed to highlight those areas with known occurrences of rare species 
or high quality natural communities. The biological rarity index is designed to help prioritize the 
known occurrence areas for conservation.  

 
Process_Description:  

The first step in the biodiversity and probability models is to group species into general habitat 
classes. The habitat classes are spatially represented using landcover data, stream lines, and rail 
corridors. These habitat layers are used to redefine the spatial extent of the rare species locations. 
Natural community locations are not subset by habitat, because all the communities have a defined 
spatial extent. 

 
Process_Description:  

Each occurrence is assigned a value based on the age of the record. This value is used to represent 
the probability that the occurrence still exists. Occurrences with a last observed date of no later 
than 1982 are assigned a value of one, occurrences between 1970 and 1982 are assigned a value of 
0.5, and occurrences prior to 1972 are assigned a value of 0.25. All natural community records are 
assigned a value of one.  

Each occurrence is also assigned three other values, one based on the species global status, one 
based on the species State status, and one based on the occurrence quality rank. The greater the 
threat of imperilment to the species, the higher the value assigned to the occurrence. In a similar 
vein, the higher the quality of each occurrence, the higher its assigned value. The rarity index 
value of each occurrence is then calculated by adding the values for the global status, state status, 
and the quality ranking, and then multiplying the sum by the probability value.  

Process_Description:  
To create the probability value for the 40 acre grid, all records in the grid are selected and assigned 
a "No Status" value. Next the records in the species database with the lowest probability of still 
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existing (value = 0.25) are selected. The 40 acre grid is intersected with the species database and 
the selected grid records are assigned a value of "Low." Next those records with a moderate 
likelihood of still existing are selected (value = 0.5). The grid layer is intersected with the species 
database and the selected grid records are assigned a value of "Moderate." Finally the records in 
the species database with the highest probability of continued existance (value = 1) are selected. 
The grid data set is intersected with the species database and the selected sections records are 
assigned a value of "High." Performing the selections and intersections in this order insures that a 
higher probability in any section feature will override a lower probability.  

To calculate the rarity index value of a given section, all the species occurrences intersecting the 
section are selected. The rarity index values of the selected species occurrences are summed and 
attributed to that grid location. The result is a rarity index value for each 40 acre block that is the 
sum of rarity index values of all occurrences falling within the block.  

Entity_and_Attribute_Overview:  
Probability represents the likelihood of encountering a rare species or high-quality natural 
community based on the age of the database record. The rarity index value is the sum of the values 
assigned to global status, state status, and quality ranking, multiplied by the probability value. 
These values are added for all occurrences intersecting each polygon grid feature.  

Distributor:  
Contact_Information:  
Contact_Person_Primary:  
Contact_Person: Edward Schools 
Contact_Organization: Michigan Natural Features Inventory 
Contact_Position: Conservation and GIS Manager 
Contact_Address:  
Address_Type: mailing address 
Address: PO Box 30444 
City: Lansing 
State_or_Province: MI 
Postal_Code: 48909 
Contact_Voice_Telephone: 517-373-0798 
Contact_Electronic_Mail_Address: schoolse@michigan.gov 
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Appendix D - Development Pressure 
 
The original data for this criterion was downloaded from the Purdue University Land 
Transformation Model web site. (http://ltm.agriculture.purdue.edu/ltm.htm). Data was in 
the form of a series of ArcGIS Grid (100 meter raster cell size) files representing actual 
land use in the state of Michigan for the year 2000 and predicted land use for the years 
2005, 2010, 2015, 2020, 2025 and 2030.  
The current MAC study compared predicted urban land use in 2005 and 2015 in each 
quarter-quarter section in the watershed to measure short-term development pressure in 
that quarter-quarter section. 
The following discussion is an extract from the Technical Users Guide to the Land 
Transformation Model II. (The entire guide can be downloaded from the website noted 
above.): 
 
The Land Transformation Model has been developed to integrate a variety of land use change driving 
variables, such as population growth, agricultural sustainability, transportation, and farmland preservation 
policies. The LTM utilizes a set of spatial interaction rules, which are organized into an object class 
hierarchy. The model is entirely coded within a geographic information system with graphical user 
interfaces that allow users to change model parameters. Output of the LTM includes a time series of 
projected land uses in the watershed at user specified time steps. 
 
Land Transformation Model is characterized by change in land use and land cover. Land use describes the 
anthropogenic uses of land as its affects ecological processes and land value (Veldkamp and Fresco 1996). 
Land uses that we consider at the most general level are: urban, agriculture/pasture, forest, wetlands, open 
water, barren and non-forested vegetation.  
Land cover characterizes the plant cover of associated land use and is thus not mutually exclusive of land 
use. Land cover types that are considered include: types of agriculture (row crops versus non-row crops), 
deciduous and coniferous forests, and non-forested vegetation. 
 
Within each land use, we consider Intensity Of Use such as land management practices, resource use and 
human activities. Intensity of use can be measured as chemical inputs to the land to increase its productivity 
(e.g., herbicides), chemical inputs as it results from human activities (e.g., salting of roads), and natural 
resource use (e.g, subsurface water for irrigation, per unit area energy consumption and forest harvesting). 
Socioeconomics, policy and environmental factors will also drive the intensity of use as well.  
 
Changes in land use and cover, and intensity of use, alter Processes (e.g., hydrogeologic and geochemical) 
and Distributions of plants and animals in ecosystems. Processes that we are interested in characterizing 
include groundwater and surface water flows, chemical and sediment transport across land and through 
rivers and streams, geochemical interactions and fluxes such as nutrients (nitrogen and phosphorus). Land 
use and land cover will affect the types and numbers of animals inhabiting areas. 
 
Land use and features (roads, rivers, etc.) in the watershed are characterized in the pilot LTM model as a 
grid of cells. Each cell is assigned an integer value based on land use (e.g., urban, agriculture, wetlands, 
forest) or land feature. Driving variable calculations produce land use conversion probabilities for each cell. 
 
In the LTM, we use the GIS to make spatial calculations between drivers of land use change and cells being 
considered for land transition. The values resulting from these calculations are converted to relative land 
transition probabilities. Relative land transition probabilities that are used range from 1 (lowest probability 
of undergoing transformation to urban land use) to 10 (greatest chance of being converted to urban land 
use). 
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Appendix E - Protected Areas 
 
 Owner/ 

Easement Holder Protected Area Name Size 
(ac) Location 

     
1 Land Conservancy of 

West Michigan 
Kuker-VanTil Nature Preserve 45 Park Twp 

2 Dune Pines Nature Presrve 13 Laketown Twp 
3 Castle Park Reserve 5 Laketown Twp 
4 Muzzy Conservation Easement 10 Laketown Twp 
     
5 Michigan Department of 

Natural Resources 
Holland State Park 142 Park Twp 

6 Olive Twp State Game Area 245 Olive Twp 
7 Blendon Twp State Game Area 40 Blendon Twp 
8 unknown 8 Park Twp 
     
9 Hope College Hope College Nature Preserve 55 Laketown Twp 
     
10 Ottawa County Upper Macatawa Conservation Area 612 Zeeland Twp 
11 12 Park Parcels 58 Park Twp 
12 Riley Trails 300 Park Twp 
13 Albert C. Keppel Forest Preserve 40 Park Twp 
14 Tunnel Park 17 Park Twp 
15 Macatawa Greenway 10 Holland Twp 
16 unknown 40 Holland Twp 
     
17 Macatawa Greenway Macatawa Greenway 65 Holland,  Zeeland 
18 Partnership MG - Buursma Easement 3 Holland Twp 
19  MG - Ridge Point Easement 150 Holland Twp 
20  MG - Cruiser Easement 21 Holland Twp 
21  MG - Dirkse Easement 12 Holland Twp 
     
22 Wildlife Unlimited Outdoor Discovery Center 100 Fillmore Twp 
22 ODC of Wildlife Outdoor Discovery Center 1 Fillmore Twp 
22 ODC Friends Outdoor Discovery Center 5 Fillmore Twp 
     
23 Park Township Ransom St. Park 20 Park Twp 
24 Pine Creek Trail 37 Park Twp 
25 Winstrom Park/Preserve 72 Park Twp 
26 Cooper-Van Wieren 66 Park Twp 
27 Wendt Fitness Park 17 Park Twp 
28 unknown 14 Park Twp 
     
29 Holland Township Dunton Park 21 Holland Twp 
30 Quincy Park 133 Holland Twp 
31 Helder Park 159 Holland Twp 
     32  Macatawa Greenway 19 Holland Twp 
     
33 Zeeland Township VanZoeren Woods 34 Zeeland Twp 
34 Drenthe Grove Park 20 Zeeland Twp 
     
35 Fillmore Township proposed 20 Fillmore Twp 
36 unknown 6 Fillmore Twp 
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37 Laketown Township Sanctuary Woods 40 Laketown Twp 
38 Wolters Woods  34 Laketown Twp 
39 The Huyser Farm 102 Laketown Twp 
40 Fairview Nature Park 87 Laketown Twp 
41 Kelly Lake 10 Laketown Twp 
42 Gilligan Lake 13 Laketown Twp 
     
43 Overisel Township unknown 50 Overisel Twp 
     
44 City of Holland Degraff Nature Center 18 Holland City 
45 Van Raalte Farm 160 Holland City 
46  Windmill Island 70 Holland City 
47  Window on the Waterfront 40 Holland City 
48  Macatawa Greenway 17 Holland City 
49  Macatawa Greenway 55 Holland Twp 
50  unknown 8 Holland City 
51  Paw Paw Recreation Preserve 48 Holland City 
52  Kollen Park 19 Holland City 
53  Lakeview Park 3 Holland City 
54  Prospect Park 7 Holland City 
55  VanBragt Park 4 Holland City 
     
56 City of Zeeland Huizenga Park 23 Zeeland City 
     
 
 
Protected Parcels are property parcels which currently (2009) have some degree of 
protection from development through their designation as parks, preserves or nature areas 
or due to the presence of a conservation easement. Parks which have extensive 
recreational facilities (playgrounds, ballfields, tennis courts, campgrounds etc.) are 
generally not included unless they have significant areas (>5 acres) of undeveloped 
forest, wetland or meadow.  
 
Protected Areas are protected parcels or groups of protected parcels. Generally, parcels 
in a protected area will have the same owner but there are some exceptions such as 
Holland’s Outdoor Discovery Center. Also, parcels in a protected area are usually 
contiguous but not always (Holland City Greenway parcels, Greenway Partnership 
parcels). 
 
The Macatawa Greenway is a projected natural corridor running along the Macatawa 
River from downtown Holland to Zeeland Township. Current components of the 
Greenway comprise both public and private lands. The project is administered by the The 
Outdoor Discovery Center - Macatawa Greenway Partnership (ODC-MGP), a nonprofit 
environmental education and conservation organization. Some components of the 
Greenway are named parks or preserves and are listed as such in the above table - 
otherwise they are listed as ‘Macatawa Greenway’. 
 
Protected areas were identified on property parcel datasets by referring to the websites of 
state, county and local government institutions and land conservation organizations in the 
watershed.  
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Appendix F - Groundwater Recharge 
 
The original data was derived from the Darcy Potential Groundwater Movement Model 
(Input-Output), developed by the Michigan DNR Fisheries Division, Institute for 
Fisheries Research. Data was in the form of a raster dataset asciito_darc2.rrd 
downloaded from the MI DNR Geographic Data Library. 
 
The following discussion was taken from the metadata (darcy_io.htm) for the model 
(ERDAS raster file asciito_darc2.rrd): 
 
GIS-based models of potential groundwater loading in glaciated landscapes: considerations and 
development in Lower Michigan. 
With this model, we implement and validate a simple, terrain-based approach for predicting groundwater 
delivery to streams and other surface water systems using mapped data within a GIS environment. Model 
output was calculated in units of m day-1 for every 30 m2 grid cell across Lower Michigan.  
The grid values produced by this DARCY model (velocity = length*time-1) represent only the potential 
groundwater velocities to a surface location. The models contain no information about the actual 
distribution or transport of water - values should be treated principally as an index of potential groundwater 
delivery. For visualization purposes, the model output values could be usefully scaled in standard 
deviations from their mean value across Lower Michigan.  
Validation was indirect because these potential velocities were not directly measurable in the field. To the 
extent that these models successfully identified locations where groundwater loading to surface systems 
could occur, groundwater-related attributes of the surface water systems could be used to test model 
predictions of spatial patterning. Likewise, we expected that model predictions should correspond to spatial 
patterns in statistical summaries of instantaneous groundwater delivery rates. Validation tests of the MRI-
DARCY Input Output model (a product of the version 3 model) were more rigorous compared to earlier 
versions.  
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Appendix G - Soil Quality 
 
The original data for this criterion was developed by the United States Department of 
Agriculture, Natural Resources Conservation Service and was obtained from the Soil 
Data Mart (http://soildatamart.nrcs.usda.gov/). 
 
The data is provided in the form of shapefiles (soilmu_a_mi005.shp and 
soilmu_a_mi139.shp) which show the spatial extent of soil types in Allegan County and 
Ottawa County respectively. In addition, a set of tabular data which contains attribute 
information on the soil types is provided, as well as a Microsoft Access template database 
(soildb_MI_2002.mdb). The tabular data can then be imported into the Access template 
and reports created. 
 
Versions used in this study: 
Allegan County Soil Survey Data (Survey Area Version 8; Tabular Data Version 7; 
Spatial Data Version 5; (SSURGOV2.1, MD 2.2.3) 
and 
Ottawa County Soil Survey Data (Survey Area Version 4; Tabular Data Version 4; 
Spatial Data Version 2; (SSURGOV2.1, MD 2.2.2). 
 
Reports were created using the Access template database and the tabular data to show the 
Map Symbols for prime farmland in the respective counties and the symbols were used to 
identify prime farmland and prime farmland when drained polygons. 
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Appendix H - Fields in the Model Dataset Attribute Table 
 

Field Data 
Type Values 

OBJECTID  Database unique identifier. Maintained by ArcGIS. 
Shape  Feature type. Maintained by ArcGIS. 
COUNTY text, 2 County code (from original q-q dataset). 
TOWN text, 3 Township code. (From original q-q dataset). 

GEO_ID text, 12 Town, range, section, quarter and quarter-quarter section. (From original q-q 
dataset). 

MAC_ID integer Project unique identifier 
Shape_Length double (m) Automatically computed for each feature. Maintained by ArcGIS. 
Shape_Area double (m2) Automatically computed for each feature. Maintained by ArcGIS. 
MAC_Acres double (ac) Calculated from Shape_Area 
MAC_Built text, 3 ‘B’, ‘L’ or ‘S’ (see Part 3 - Creation of Model Dataset) 
M1 float % of QQ with Urban land cover 
M19 float % of QQ with Recreation land cover 
M2 float % of QQ with Agricultural land cover 
M29 float % of QQ with Built Agricultural land cover 
M31 float % of QQ with Open land cover 
M32 float % of QQ with Shrubland land cover 
M4 float % of QQ with Forest land cover 
M429 float % of QQ with Plantation land cover 
M5 float % of QQ with Water land cover 
M53 float % of QQ with Reservoir land cover 
M6 float % of QQ with Wetland land cover 
M7 float % of QQ with Bare land cover 
MH2 double (m) Length of lake perimeters (H21) in QQ 
MH3 double (m) Length of rivers (H31, H32 and H33) in QQ 
MH4 double (m) Length of drains (H41) in QQ 
MRI float Project index of species rarity for each QQ. (see DP 5) 
MDev double (m2) Difference between 2005 and 2015 projected urban land cover area. (see 2.6). 
MPrx integer Index of adjacency of QQs to already protected areas (1 - 5). (see 2.7). 
MGw double Index of groundwater delivery to streams and ponds. (see 2.8). 
MFm double % of QQ with prime farmland soil type. 
***_PS integer A separate protection score field for each of the above criteria fields. 
Total_PS integer Sum of  ‘***_PS’ fields 
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Appendix I - Protection Criteria Classification and Weighting Worksheet. 
 

Criterion Field Classification QQs Bw2   
    Score   
LandCover       
       
     Built M1_PS   0   
(developed land cover).       
       
     Recreation M19_PS =< 30% 2848 0   
(% of recreation land  > 30 - =< 60 26 2   
cover in q-q).  > 60% 24 4   
       
     Agricultural M2_PS =< 30% 1213 0   
(% of agricultural land  > 30 - =< 60 332 2   
cover in q-q).  > 60% 1353 4   
       
     Built Ag M29_PS   0   
(agricultural structures)       
       
     Open Land M31_PS < 5% 2421 0   
(% of open land cover  => 5 - < 25 332 1   
in q-q).  => 25 - < 40 77 2   
  => 40 - < 50 32 6   
  => 50 - < 60 14 10   
  => 60 - < 70 9 14   
  => 70 - < 80 7 18   
  => 80% 6 22   
       
       
     Shrubland M32_PS < 5% 2531 0   
(% of shrubland land  => 5 - < 25 275 2   
cover in q-q).  => 25 - < 40 55 4   
  => 40 - < 50 12 8   
  => 50 - < 60 11 12   
  => 60 - < 70 4 16   
  => 70 - < 80 8 20   
  => 80% 2 24   
       
     Forest M4 < 5% 1825 0   
(% of forest land cover  => 5 - < 25 584 5   
in q-q).  => 25 - < 40 191 9   
  => 40 - < 50 87 13   
  => 50 - < 60 72 17   
  => 60 - < 70 44 21   
  => 70 - < 80 35 25   
  => 80% 60 29   
       
     Plantation M429 <= 10% 2892 0   
(% of plantation land  > 10 - <= 30 2 3   
cover in q-q).  > 30 - < = 60 3 5   
  => 60% 1 7   
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     Water M5 <= 10% 2796 0   
(% of open water in q-q).  > 10 - <= 30 39 2   
  > 30 - < = 60 22 3   
  > 60% 41 4   
       
     Reservoir M53 <= 25% 2896 0   
  > 25% 2 2   
       
     Wetland M6 < 1% 2709 0   
(%  of wetland cover)  => 1 - < 5 63 3   
  => 5 - < 10 42 6   
  => 10 - < 15 30 9   
  => 15 - < 20 14 12   
  => 20 - < 25 17 15   
  => 25% 23 19   
       
     Bare M7 =< 30% 2895 0   
(% of bare land cover)  > 30 - =< 60 2 2   
  > 60% 1 3   
       
       
       
Hydro       
     Lakes & Ponds MH2 < 10m 2705 0   
(meters of pond perimeter  => 10 - < 100 11 2   
in q-q).  => 100 - < 300 68 3   
  => 300 - < 500 71 5   
  => 500 - < 650 24 7   
  => 650m 19 9   
       
     Rivers MH3 < 10m 2462 0   
(meters of rivers in q-q).  => 10 - < 100 46 8   
  => 100 - < 300 107 10   
  => 300 - < 500 179 12   
  => 500 - < 650 59 15   
  => 650m 45 18   
       
     Drains MH4 < 10m 1917 0   
(meters of drains in q-q).  => 10 - < 100 109 3   
  => 100 - < 300 271 5   
  => 300 - < 500 387 7   
  => 500 - < 650 139 9   
  => 650m 75 11   
       
Species Rarity Index MRI 0 1046 0   
(index of likelyhood of   > 0 - <= 5 1226 1   
rare species in q-q).  > 5 - <= 8 530 3   
  > 8 - <= 10 61 6   
  >10 35 9   
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Development Pressure MDev <= 4047m2 1647 0   
(predicted increase in  > 4047 - <= 24282 566 1   
 area (m2) developed).  > 24282 - <= 40470 383 2   
  > 40470 - <= 60705 229 3   
  >  60705m2 73 4   
       
Proximity to Protected MPrx 0 2642 0   
(index of proximity to   1 110 10   
protected land.  2 34 7   
See page 17).  3 26 0   
  4 10 0   
  5 76 7   
       
Ground Water Recharge MGw <= 0 2088 0   
(average positive recharge  > 0 - <= 10 508 1   
rate in a q-q).  > 10 - <= 40 225 3   
  >40 77 5   
       
Prime Farmland MFm 0% 978 0   
(% of q-q with prime   > 0 - <=30 284 -1   
farmland soil type).  > 30 - <= 60 333 -2   
  > 60 - <= 90 515 -3   
  >90% 788 -4   
Total QQs = 2898, B = classification version,  QQs = # of QQs in class,  Bw2 = protection scores for 
classification B. (Bw2 is also the version number for this model outcome). 
 
Scores in the worksheet can be changed by changing the numbers in the ***_PS fields in 
the model. For example, the procedure for changing the maximum score for Recreation 
land cover from 4 to 6 is as follows: 
 
Start by saving MAC2.gdb\MAC_Model_A with a new name (MAC_Model_A2). You 

might want to create a new file geodatabase and export Model_A to it, changing the 
name in the process. 

 
In ArcMap, open the attribute table of MAC2.gdb\MAC_Model_A2.  
 
From the Menu bar choose Selection>Select by Attributes>Select from MAC_Model_A2 

where “M19_PS” = 4 
 
Click OK. 
 
Now the appropriate records are selected in the attribute table. Click the Show Selected 

button to see them. 
 
Find the M19_PS field (column). Rt-click on the header and choose Field Calculator. 
 
Type 6 in the big box. Click OK and the 4 values will change to 6. Note that this applies 

to selected records only. 
Note that VBA expressions (*.cal) can be used to simplify changing scores for attributes.  
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Appendix J – Problems Encountered in Creating the Model 
 
There are a number of problems that may result in iterations of the model which do not 
produce acceptable results. Some problems are inherent in the nature of the data used or 
in the design of the model. Others are the result of the way the data is classified and 
weighted.  
 
Problems inherent in the data include the following: 
Problems of scale. Groundwater recharge data is accurate to 30 meters. Land 
Transformation Model values are based on a 100 meter grid. MNFI Biological Rarity 
values are reported on a 40-acre grid but this grid does not match the 40 acre quarter-
quarter section grid. 
Inaccurate data. Remote sensing is not able to distinguish land cover types with perfect 
accuracy; e.g. when imagery is obtained during dry periods, unforested wetland may be 
confused with farmland. Species rarity determination relies on reports by human 
observers thus more sightings tend be made in areas where there are more people. 
Development pressure values are themselves based on a computer model which 
undoubtedly has its own problems. 
Changes in conditions (e.g. land cover) since the latest available data was created. 

 
Problems inherent in model design include: 
Quarter-quarter section units in the base layer are not all the same size. The large 
majority are approximately 40 acres but some quarter-quarter sections along county and 
watershed borders are considerably smaller. The value of these small quarter-quarter 
sections may tend to be overestimated. 
Land cover is measured by percentage of quarter-quarter section area. Land cover types 
in a quarter-quarter section are usually in contiguous blocks but where they are divided 
up (by a large highway, for example) the protection value will actually be less than that 
indicated by the protection score. 
Different systems of classifying the data and weighting the classes will give different 
outcomes. Outcomes should be tested against aerial imagery, parcel data and other digital 
resources and by ground truthing wherever possible. 
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Appendix K – Map Symbology 
 
Symbology determines how the model outcomes will be displayed in a map. 
 
The symbology for a feature class (dataset) is saved in a map (.mxd) document or a layer 
file (.lyr) – but not with the shapefile or geodatabase feature class that contains the map 
layer’s data. 
 
A particular dataset can be symbolized in many different ways for any of its attributes 
and each way can be saved in the same map or a different map or as a different layer file. 
The data remains the same, only the appearance changes. 
 
The following is the procedure for symbolizing the model used in this study based on its 
Total_PS attribute: 
 
Right-click the model layer name in ArcMap and choose Properties and then the 
Symbology tab. 
 
In the left pane choose View: Quantities > Graduated Colors. 
 
For Fields choose TOTAL_PS. 
 
Click the Classify button. Set to 6 classes (or however many you want) and choose 
Manual. 
 
Set the Break Values to correspond to the number of units you want in each class (tier).  
Click on each break value to show the number of elements in each class (at the bottom of 
the window). This should correspond to the number of quarter-quarter sections (QQs) for 
each class in the Worksheet. 
 
Experiment with number and size of classes until you find a symbology which represents 
the data in the simplest and most useful way possible. 
 
Note: You can change the colors without changing the classification. 
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